ENTIS R101.1
Installation and Configuration Guide
Copyright 2019 Honeywell. All rights reserved.

Reproduction in any form without the prior consent of Honeywell is not allowed. This manual is for information only. The contents, descriptions and specifications are subject to change without notice. Honeywell accepts no responsibility for any errors that may appear in this manual.

The warranty terms and conditions applicable in the country of purchase in respect to Honeywell products are available from your supplier. Please retain them with your proof of purchase.

For service-related questions, contact:

Technical Assistance Centre
Phone: +31152701246
E-mail: HFS-TAC-SUPPORT@honeywell.com

See back page for more details

Copyright © 2019 - Honeywell
All rights reserved. No part of this manual may be reproduced in any form, by print, photoprint, microfilm or any other means without the written permission from Honeywell.
ABOUT THIS GUIDE

This manual describes how to install and configure the ENTIS system. It has been written for the operators as well as system supervisors to provide them with all the information required to install and configure the system.

Safety and prevention of damage

‘Cautions’, and ‘Notes’ have been used throughout this manual to bring special matters to the immediate attention of the reader.

A Caution draws attention to an action which may damage the equipment.

A Note points out a statement deserving more emphasis than the general text, but does not deserve a “Warning” or a “Caution”.

Additional information

Contact Honeywell or its representative, if you require additional information. Also, refer to the list of related documents in Documentation References.

Legal aspects

The information in this manual is copyright property of Honeywell. Honeywell disclaims any responsibility for personal injury or damage to equipment caused by:

- Deviation from any of the prescribed procedures
- Execution of activities that are not clearly documented

Support

For support, contact your local Honeywell Process Solutions Customer Contact Centre (CCC). To find your local CCC visit the website, https://www.honeywellprocess.com/en-US/contactus/pages/default.aspx
Revision History

ENTIS Installation and Configuration Guide (This document)

<table>
<thead>
<tr>
<th>ETDOC-X613-en-101A</th>
<th>September 2019 (1st Release)</th>
</tr>
</thead>
</table>

DOCUMENTATION REFERENCES

The following list identifies publications that may contain information relevant to the information in this document.

<table>
<thead>
<tr>
<th>ETDOC-X612-en-101A</th>
<th>ENTIS Quick Start Guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>EHDOC-X136-en-510A</td>
<td>Experion HS Software Installation Users Guide</td>
</tr>
</tbody>
</table>


Contacts

See back page for details
## TABLE OF CONTENTS

1 INTRODUCTION .................................................................................................................. 1  
2 HARDWARE REQUIREMENTS ............................................................................................. 2  
3 SOFTWARE REQUIREMENTS ............................................................................................... 3  
  3.1 PREREQUISITE SOFTWARE .......................................................................................... 3  
4 INSTALLATION OF ENTIS ................................................................................................. 4  
  4.1 PREREQUISITE ............................................................................................................. 4  
  4.2 INSTALLING ENTIS AS A SERVER ............................................................................. 4  
  4.3 INSTALLING ENTIS AS CLIENT OR USER INTERFACE ........................................... 9  
  4.4 VERIFYING SUCCESSFUL INSTALLATION ............................................................... 10  
5 CONFIGURING THE ENTIS SYSTEM ............................................................................... 11  
  5.1 STARTING CONFIGURATION STUDIO ........................................................................ 11  
  5.2 CONFIGURING ASSETS ............................................................................................ 13  
  5.3 LOADING ASSET MODEL ON TO SERVERS IN THE SYSTEM ................................... 16  
  5.4 BUILDING CHANNELS ............................................................................................... 19  
  5.5 BUILDING CONTROLLERS .......................................................................................... 24  
6 MIGRATING CIU 888 DATABASE ....................................................................................... 29  
  6.1 DOWNLOADING THE EQUIPMENT TEMPLATES ......................................................... 31  
7 CREATING FLEX OR CLIENT STATIONS (MULTI USER) ............................................... 35  
8 SETUP LOGGING SETTINGS .............................................................................................. 37  
9 INSTALLING THE ENTIS LICENSE ................................................................................ 38
TABLES

TABLE 2-1: ENTIS AS A SERVER................................................................. 2
TABLE 2-2: ENTIS AS A CLIENT............................................................... 2
TABLE 5-1: SCAN TASK CHANNEL PROPERTIES .................................. 21
TABLE 5-2: USER SCAN TASK CONTROLLER PROPERTIES ...................... 25
INTRODUCTION

This guide introduces you to software & hardware requirements, prerequisites and procedures for installing ENTIS as a Server or Client system.

This document provides information on how configuring an ENTIS system. It describes how to create Channels, Controllers & Equipment for an ENTIS system using Configuration Studio, and how to download them to an Experion server. In addition, it also explains how to export the database from a CIU 888 and how to configure the ENTIS license.

Reference document
For more information on using Configuration Studio, refer to Experion HS Configuration Studio Overview, EHDOC-X113-en-500.
2 HARDWARE REQUIREMENTS

The hardware systems that are recommended for installation and use of ENTIS as a Server and Client are given in the following tables.

**ENTIS as a Server**

Table 2-1: ENTIS as a SERVER

<table>
<thead>
<tr>
<th>System Configuration</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Single Intel Xeon Processor E5-1620v3, 3.50GHz (or equivalent)</td>
</tr>
<tr>
<td>RAM</td>
<td>8GB</td>
</tr>
<tr>
<td>Networking</td>
<td>100 Mbps Ethernet</td>
</tr>
<tr>
<td>Video resolution</td>
<td>1600x1200, 1680x1050, 1920x1200, 1920x1080; 65K colours</td>
</tr>
<tr>
<td>Hard drive</td>
<td>500GB</td>
</tr>
<tr>
<td>Example Hardware</td>
<td>Dell T5820XL Tower Workstation</td>
</tr>
<tr>
<td></td>
<td>Dell R7920XL Rack Workstation</td>
</tr>
</tbody>
</table>

**ENTIS as a Client**

Table 2-2: ENTIS as a Client

<table>
<thead>
<tr>
<th>System Configuration</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Single Intel Processor i3-4330, 3.50GHz (or equivalent)</td>
</tr>
<tr>
<td>RAM</td>
<td>8GB</td>
</tr>
<tr>
<td>Networking</td>
<td>100 Mbps Ethernet</td>
</tr>
<tr>
<td>Video resolution</td>
<td>1600x1200, 1680x1050, 1920x1200, 1920x1080; 65K colours</td>
</tr>
<tr>
<td>Video Memory</td>
<td>512MB VRAM per channel</td>
</tr>
<tr>
<td>Hard drive</td>
<td>500GB</td>
</tr>
<tr>
<td>Example Hardware</td>
<td>Dell OptiPlex XE2, OptiPlex 3040, HP 400G3 or equivalent</td>
</tr>
</tbody>
</table>
3 SOFTWARE REQUIREMENTS

The following software is required for the successful installation of ENTIS.

- Experion HS 510.2 server patch
  For access mail to HPSWeb@Honeywell.com

The ENTIS installation will fail if installed on any operating system other than Windows 10 LTSB or in any environment other than Experion HS.

3.1 PREREQUISITE SOFTWARE

ENTIS must be installed on a system where Experion HS 510.2 server patch is already installed and configured.


<table>
<thead>
<tr>
<th>ENTIS Client/Server</th>
<th>Software</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Operating System</td>
<td>Microsoft Windows 10 Enterprise 2016 LTSB (64bit)</td>
</tr>
<tr>
<td></td>
<td>Browser type</td>
<td>Microsoft Internet Explorer 11</td>
</tr>
</tbody>
</table>
4  INSTALLATION OF ENTIS

4.1  Prerequisites
Ensure the following applications are available in the system before installing ENTIS:

- Experion HS 510.2 Server patch

4.2  Installing ENTIS as a Server
Perform the following steps to install ENTIS as a server in your system:

1. Right-click the installer application **Setup** in the disk and run it as Administrator.

The **ENTIS – Install Shield Wizard** appears.
2. Click **Next**. The **License agreement** screen appears. Select the “I accept the terms…” option and click **Next**.

![License Agreement Screen]

*The Program Maintenance screen does not appear if you are installing ENTIS for the first time.*

3. Click **Next**. The **Custom Setup** screen appears.

![Custom Setup Screen]
If .NET framework 4.7.2 is not present, ENTIS installer will only install when ‘ENTIS’ feature is selected for installation.

4. Select ENTIS and click Next. The Service account details screen appears.

5. Enter the Valid password for the ENTIS User account. Click Next.
6. Click Install.
After a successful installation, the **Install Shield Wizard Completed** screen appears.

**NOTE: Restart is required after the installation is completed.**

The ENTIS application is successfully installed in your system as a server.
4.3 Installing ENTIS as Client or User Interface

Perform the following steps to install ENTIS as Client or User Interface in your system:

**NOTE: For Client /User Interface only, not for Server use**

1. Perform steps 1 and 2 from section 4.2 procedure above.
2. In the Custom Setup screen, click the drop-down button to the left of ENTIS and choose This feature will not be available option.
3. Select the option ENTIS User Interface.
4. Click Next.
5. Follow the remaining steps from the previous procedure to complete installing ENTIS as client in your system.
4.4 Verifying successful installation

Perform the following steps to ensure that ENTIS is successfully installed in your system.

1. In the Experion Station, go to STATION>Connect to view the Connect window listing ENTIS as shown below.

![Connect window showing ENTIS](image1)

2. Click Connect.
3. ENTIS appears on the main menu of the Experion Station as shown below.

![Main menu showing ENTIS](image2)

You have verified that the ENTIS application has been successfully installed in your system.
5 CONFIGURING THE ENTIS SYSTEM

Configuring ENTIS means to customize the Experion server database for your plant. It involves defining communication connections, and the data acquisition and control that you want to implement at your site.

ENTIS is configured according to the end user requirements using Configuration Studio, which is installed as a part of Experion installation.

5.1 Starting Configuration studio

Prerequisites

You must have an Experion operator account on the Experion server to which you want connection.

If this is a new installation, use the default mngr account.

To start the Configuration Studio:

Perform the following steps to start Configuration studio:

1. Choose Start > All Programs > Honeywell Experion PKS > Configuration Studio. The Configuration Studio window appears.

2. Go to File>Connect to open the Connect dialog box.
3. In the Connect dialog box, click Other Targets tab.
4. In the Target Type drop down box, select Experion System.
5. In the **Target Name** text box, type *localhost*
   Alternatively, you can specify the IP address of the server.
6. Click **Connect**.

![Select a system when you want to configure your asset model, configure your Network tree, or select a server for specific tasks.]

7. Log on to **Configuration Studio**.

   The login prompt is only displayed if the account used to log on to Windows is not configured as an operator either directly or via Windows group membership, that is, if your system is not using single sign on. If single sign on is enabled, you do not need to enter a name or password, or select a domain name.

   a. Type the operator name and password.
   b. In the Domain list, select one of the following:

<table>
<thead>
<tr>
<th>If...</th>
<th>Select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The operator name is maintained in a Windows domain</td>
<td>The Windows domain name</td>
</tr>
<tr>
<td>The operator name is maintained on the server or system that you are connecting, and you use integrated security</td>
<td><em>Servername</em> (the target)</td>
</tr>
<tr>
<td>You are using traditional operator security</td>
<td>&lt;Traditional Operator Security&gt;</td>
</tr>
</tbody>
</table>
   c. Click **OK**.
8. Results
Configuration Explorer is populated with a tree of items that you can configure for your system as shown below.

5.2 Configuring Assets
Assets are items that make up the asset model.

Prerequisites
- You have a security level of ENGR or higher. See Documentation References
  Refer to ENTIS User’s Guide, ETDOC-615-en-R101
- You have launched Configuration Studio and connected to an Experion system. You can only configure assets within an Experion system. You cannot configure assets when connected only to an Experion server.
- You have already configured the system and added servers to the system using Configuration Studio.
To configure assets:

1. In the **Configuration Explorer** in Configuration Studio, select the highest-level system node.
2. In the right pane, under **System Tasks**, click **Configure Assets for this system**.

3. The **Enterprise Model Builder - Asset** window appears. The left side of the window shows an Asset tree view containing the asset model structure.
If the Asset tree view window is not visible, click Open Tree on the toolbar to open the asset model.

4. Choose File > New ASSET. The **ASSET Block Parameters** dialog box appears.

5. In the **Tag Name** box, Enterprise Model Builder has already assigned a default tag name. Type a new unique tag name.

6. In the **Item Name** box, Enterprise Model Builder has already assigned a default item name. Type another item name, if you require a different item name.

7. In the **Description** box, type a description of the asset.

8. In the **Point Detail Page** and **Associated Display** boxes, type the name of the associated displays.

9. Select the **Directly Assignable** (for scope of responsibility and alarm enable/disable) check box if you want the asset to be assignable to an operator, Station, or alarm group. The icons for unassigned assets in the Asset tree view appear dimmed.

10. Click the **Identification** tab.

11. In the **Block Comment** boxes, type additional information about the asset.

12. Click **OK** to create the asset. The asset appears in the Asset tree view.

**You can arrange assets within the asset tree view by the clicking on the asset icon, and then dragging and dropping the icon to the new location.**
5.3 Loading Asset Model on to Servers in the System

The asset model can be loaded to servers that are configured as part of the Enterprise Model. The asset model can be loaded to the Experion server. This operation loads the entire asset model to the selected servers. The entire model includes the system configuration and all defined items in the model, which includes the top-level asset and all assets groups associated with that item. Individual assets cannot be loaded; assets are loaded as a model.

_During the load operation, assets and points may temporarily belong to unassigned items in the Alarm Summary display._ The tree view on the left of the display may show an incomplete model. These conditions should clear once the download is completed. When you start the load process, all items of the Asset model and all configured servers selected for load are locked to other users. If the asset model to be loaded is already locked, an error is reported and the load operation is aborted. If any of the configured servers are already locked an error is reported and the load operation is aborted.

**Prerequisites**
- You have a security level of ENGR or higher.
- A system model has been defined, consisting of at least one server.
- An asset model, have been defined.
- You have the Enterprise Model Builder window open with either an Asset tree view displayed.
To load the asset model onto servers in the system:

1. In Enterprise Model Builder, choose Tools > Load Entire Model or click Load Entire Model on the toolbar. The Enterprise Model Builder - Load window appears.

   ![Enterprise Model Builder - Load window](image)

   - Asset to Load: Asset_SID
   - Date last changed: 07/20/2004 01:03:44:0000

<table>
<thead>
<tr>
<th>Load</th>
<th>Server Name</th>
<th>Date Loaded To Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑</td>
<td>XGTV_38V2</td>
<td>07/14/2004 03:41:24:0000</td>
</tr>
<tr>
<td>☑</td>
<td>JSER Server</td>
<td></td>
</tr>
</tbody>
</table>

   - Force Load (will override existing system and repository name)

   - OK, Cancel, Help

2. In the Load column, select the check boxes of the servers that you want to download the asset to. Clear the check box of any servers that you do not want to load asset to.

   **If no servers are selected, the OK button is disabled.**

3. If required, select the Force Load check box to allow the load to proceed even if the system name or repository name has changed.

4. Click OK to begin the asset or alarm group load to the selected servers.
The **Loading Asset** dialog box appears, showing the name of the top-level asset or alarm group that is being loaded. A progress bar shows the duration of the load operation.

**Results**

The load operation validates all server names of all the configured servers in the system, as well as the point and full item names of the asset model. If the load operation is successful without detection of any errors or warnings, a load status of Complete appears. If any errors occur during the load operation, correct the fault and then perform the load procedure again.

*Use online help manual to get more information about the page at any point of time within the application. Press F1 to access Online help.*
5.4 Building Channels

Channels are the communications link between controllers and the Experion server. You can build SCADA channels using Quick Builder in Configuration Studio.

To build a channel using Quick Builder

1. In the Configuration Explorer tree, click Control Strategy to view the menu option on the right pane.

2. In the right pane, under SCADA Control, click on Build channels. The Channels window appears.

3. In the Channels window, right-click and choose Add Items menu option.
The **Add Items** dialog box appears.

In the **Number of Items** text box, type the number of channels you want to add.

4. From the **Item Family** list, select **Channel**.

5. From the **Item Type** list, select **User Scan Task Channel**.

6. In the **Name** text box, type in the name for this channel, or you can accept the default provided. If you have chosen to create multiple channels, the Multi – Items section is enabled, and you can provide a prefix for all the channels, or you can accept the default provided. You can also indicate whether to use a sequential number or letter to differentiate between the channels.

When building controllers and channels for use with equipment, or to be referenced by Equipment Templates, do not include underscores or hyphens in the names specified for the controller or channel.

7. Click **OK** to add the channel(s) to the list.

Alternatively, you can also drag and drop the channels from the right panel to the Channels window to create Channel.
Main properties of a user scan task channel

The Main tab defines the basic properties for a user scan task channel.

Table 5-1: Scan Task Channel properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The unique name of the channel. A maximum of 10 alphanumeric characters (no spaces or double quotes). Note: In Station displays, underscore characters (_) appear as spaces.</td>
</tr>
<tr>
<td>Description</td>
<td>(Optional) A description of the channel. A maximum of 132 alphanumeric characters, including spaces.</td>
</tr>
<tr>
<td>Associated asset</td>
<td>The ENTIS asset that an operator must have access to in order to see system alarms from this system interface.</td>
</tr>
<tr>
<td>Marginal Alarm Limit</td>
<td>The communications alarm marginal limit at which the channel is declared to be marginal. When this limit is reached, a high priority alarm is generated. To change the priority of the alarm system wide, see the topic titled &quot;Configuring system alarm priorities&quot; in the Server and Client Configuration Guide. To change the priority of the alarm for one channel, see the topic titled &quot;About configuring custom system alarm priorities for an individual channel or controller&quot; in the Server and Client Configuration Guide.</td>
</tr>
<tr>
<td></td>
<td>A channel barometer monitors the total number of requests and the number of times the controller did not respond or response was incorrect. The barometer increments by two or more, depending on the error, and decrements for each good call.</td>
</tr>
<tr>
<td></td>
<td>To calculate an acceptable marginal alarm limit, use the formula: Square root of the number of controllers on the channel × Marginal Alarm Limit defined on those controllers (Normally, you specify the same value for all controllers on a channel).</td>
</tr>
<tr>
<td></td>
<td>For example, if there are 9 controllers on the channel and their Marginal Alarm Limit is set to 25, the value would be 3 (which is the square root of 9) × 25 = 75.</td>
</tr>
<tr>
<td>Fail Alarm Limit</td>
<td>The communications alarm fail limit at which the channel is declared to have failed. When this barometer limit is reached, an urgent alarm is generated. To change the priority of the alarm system wide, see the topic titled &quot;Configuring system alarm priorities&quot; in the Server and Client Configuration Guide. To change the priority of the alarm for one channel, see the topic titled &quot;About configuring custom system alarm priorities for an individual channel or controller&quot; in the Server and Client Configuration Guide.</td>
</tr>
<tr>
<td></td>
<td>Set this to double the value specified for the channel Marginal Alarm Limit.</td>
</tr>
<tr>
<td>Item Type</td>
<td>Shows the channel type.</td>
</tr>
<tr>
<td>Last Modified</td>
<td>Shows the date of the most recent modification to this channel's property details.</td>
</tr>
<tr>
<td>Item Number</td>
<td>The unique item number currently assigned to this item. You can change the item number if you need to match your current server database configuration. The number must be between 1 and the maximum number of channels allowed for your system (the maximum is shown on the Sizing tab for the server).</td>
</tr>
<tr>
<td>Last Downloaded</td>
<td>The date on which the item was last downloaded to the server.</td>
</tr>
</tbody>
</table>
Downloading the Channels
The channels that are created are to be downloaded to the Experion server.

To download the channels to server:
1. Click the download button on the tool bar. The **Download** dialog box appears.

![Download dialog box](image)

2. Click **Download**. The channel created will be downloaded to Experion server.
3. The **Results** message box will be displayed after successful completion of download.
4. Click **OK**.

![Results dialog box with successful download message and file details](image-url)
5.5 Building Controllers

Controllers are devices used to monitor and control processes and items of field equipment. A controller is linked to the Experion server by a Channel. You can build SCADA controllers using Quick Builder in Configuration Studio.

To build a Controller using Quick Builder:

1. In the Configuration Explorer tree, click Control Strategy to view the menu option on the right pane.
2. Under SCADA Control, click on Build Controllers.

The Controllers window appears.

3. In the Controllers window, right-click and choose Add Items menu option.
The Add Items dialog box appears.

4. In the Number of Items text box, type the number of controllers you want to add.
5. From the Item Family list, select Controller family.
6. From the Item Type list, select User Scan Task Controller.
7. In the Name text box, type in the name for this controller, or you can accept the default provided.
8. Click OK to add the controller(s) to the list.

Main properties for a user scan task controller

The Main tab defines the basic properties for a user scan task controller.

Table 5-2: User Scan Task Controller properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The unique name of the controller. A maximum of 10 alphanumeric characters (no spaces or double quotes). Note: In Station displays, underscore characters (_) appear as spaces.</td>
</tr>
<tr>
<td>Description</td>
<td>(Optional) A description of the controller. A maximum of 132 alphanumeric characters, including spaces.</td>
</tr>
<tr>
<td>Associated asset</td>
<td>The asset that an operator must have access to in order to see system alarms from this system interface. If you leave the associated asset field empty, the system alarms for this system interface will be seen by anyone who has access to the system alarms for the server on which this system interface is configured.</td>
</tr>
<tr>
<td>Channel Name</td>
<td>The name of the channel on which the controller communicates. (You must have already defined the generic channel so that it appears in this list.)</td>
</tr>
</tbody>
</table>
### Marginal Alarm Limit
The communications alarm marginal limit at which the controller is declared to be marginal. When this limit is reached, a high priority alarm is generated. To change the priority of the alarm system wide, see the topic titled "Configuring system alarm priorities" in the *Server and Client Configuration Guide*. To change the priority of the alarm for one controller, see the topic titled "About configuring custom system alarm priorities for an individual channel or controller" in the *Server and Client Configuration Guide*.

A controller barometer monitors the total number of requests and the number of times the controller did not respond or response was incorrect. The barometer increments by two or more, depending on the error, and decrements for each good call.

The default value is 25.

### Fail Alarm Limit
The communications alarm fail limit at which the controller is declared to have failed. When this barometer limit is reached, an urgent alarm is generated. To change the priority of the alarm system wide, see the topic titled "Configuring system alarm priorities" in the *Server and Client Configuration Guide*. To change the priority of the alarm for one controller, see the topic titled "About configuring custom system alarm priorities for an individual channel or controller" in the *Server and Client Configuration Guide*.

Set this to double the value specified for the controller Marginal Alarm Limit.

The default is 50.

<table>
<thead>
<tr>
<th>Item Type</th>
<th>Shows the controller type.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Modified</td>
<td>Shows the date of the most recent modification to this controller's property details.</td>
</tr>
<tr>
<td>Item Number</td>
<td>The unique item number currently assigned to this item. You can change the item number if you need to match your current server database configuration. The number must be between 1 and the maximum number of channels allowed for your system (the maximum is shown on the Sizing tab for the server).</td>
</tr>
<tr>
<td>Last Downloaded</td>
<td>The date on which the item was last downloaded to the server.</td>
</tr>
</tbody>
</table>
Downloading Controllers
The channels that are created are to be downloaded to the Experion server.

To download the Controller to server:

1. Click the download button 🔄 on the tool bar. The Download dialog box appears.

2. Click Download. The Controller created will be downloaded to Experion server.
3. The **Results** dialog box appears after successful completion of download.

![Results dialog box](image)

---

4. Click **OK**.
6 MIGRATING CIU 888 DATABASE

Database is created using CIU 888 Service Tool and Migrated to ENTIS. Perform the following steps to migrate the CIU 888 database for ENTIS.

**You must be a system administrator to perform the database export.**

1. Copy the CIU 888 database to the folder
   
   C:\ProgramData\Honeywell\ENTIS\Database

2. Launch a command prompt window (run as administrator) and type the following command:

   ```
   cd C:\Program Files (x86)\Honeywell\ENTIS
   ```

3. Type command “Migrate.exe [ciu888 database name]” add the name of the database in the path

   (C:\ProgramData\Honeywell\ENTIS\Database). For example, Migrate.exe “80TanksRed.mdb”

4. When the commissioning is executed for the first time, the application will show the default content which might be incorrect. Type N if the names are not appropriate as per the configuration.
5. The application gets executed and provides the following details when manual entry of below items is to be entered

Channel Name
Channel Number
Controller Name
Controller Number
ENTIS EPKS Asset

Controllers and Channels

In Experion, the term 'controller' is the generic term for devices such as and so on, which are used to monitor and control one or more processes and items of field equipment.

In an Experion system, controllers are connected to the server so that the server can coordinate the monitoring and supervising of all your plant processes.

The communication links that connect controllers to the server are known as 'channels.' Every controller in your system (other than the Experion Process Controllers and point servers) must be associated with a channel. Depending on the type of controllers and the type of communications line you used to connect them to the server, you may have more than one controller on a channel.

Assets are items that make up the asset model.
6.1 Downloading the Equipment Templates

Experion uses the term *Equipment* to represent physical equipment in a plant, such as well heads, pumps, generators. Equipment typically has many associated items – points, channels, controllers – so templates have been created on which you can base new equipment, therefore making the task much quicker and simpler than creating everything individually. You can build Equipment using Quick Builder in Configuration Studio.

To build Equipment using Quick Builder:
1. In the Configuration Explorer tree, click Control Strategy to view the menu option on the right pane.
2. Under SCADA Control, click on Build equipment

The **Equipment** window appears

3. In the Equipment window, go to File>Import. The Select file to import dialog box appears.
4. Choose the path
C:\Users\Public\Documents\Honeywell\ENTIS\EquipmentTemplate

5. From the Files of Type list, select Equipment Template

6. Select all the files displayed in the window and click Open. The template files are to import to Experion HS server.

7. The Results message box appears after successfully importing the equipment templates.
8. Click OK.

9. In the **Library** panel, on the right-hand side, you can view the equipment under **Oil and Gas Library**.
1. Relaunch the application and press Y.

2. The application will continue deleting and regenerating the point files. Located at: C:\ProgramData\Honeywell\ENTIS\NewPoints

3. The user will be asked whether to continue downloading the point files to Experion or not.

4. If you want to download press Y, else press N.

   Download time varies depending on the size of the database.

   You have exported CIU 888 database successfully.
7 CREATING FLEX OR CLIENT STATIONS
(Multi user)

You can create and configure more than one station using Quick Builder.

To create a Station using Quick Builder:

1. In the **Quick Builder** window tree view, click **Stations**.
   The Stations window appears.
2. In the **Stations** window, right-click and select the **Add Items**.
   The **Add Items** dialog box appears.

3. Type the number of items you want to create in the **Number of items** field. If you choose to create more than one item, extra fields appear where you can define the suffix applied to each item name. The variable used can be numbers of letters.
4. From the **Item Family** list, select the applicable family. If you used a template or a right-click menu option to invoke this dialog, this field will default to the template type or the item you had selected at the time.
5. From the **Item Type** list, select the item type.
6. In the **Name** text box, type in the name for this item, or you can accept the default provided. A summary of the details you have provided is displayed.
7. Click **OK** to add the item(s) to the list.
   The new items appear in the **List View**.
8. Click the download button on the toolbar.
The **Download** window appears.

9. Click the **Download** button.
10. The **Results** message box will be displayed after successful completion of download.

11. Click **OK**.
8 SETUP LOGGING SETTINGS

In Experion station go to menu configure -> system hardware -> Server wide settings

Uncheck the Disable writes via the Network API check box in Server Wide Settings.

Note: The checkbox must be unchecked to be able to see ENTIS events in Experion station.
9 INSTALLING THE ENTIS LICENSE

License file should be named ENTISR101.lic and placed in the following path:
C:\ProgramData\Honeywell\ENTIS\License.

The installer will create the folder, but the License file should be placed manually. Scanner will work only if there is valid license from the current build. When there is no valid license found in the path, ENTIS station will throw an error message as shown below.

INVALID LICENSE

Uninstall ENTIS program

1. Open the Start menu.
2. Type “Control Panel” and select.
3. Select “Programs and Features” to display “Uninstall or change a program” screen
4. Select ENTIS app from the list to uninstall.
5. Click the Uninstall button that appears.
INDEX

.NET framework 4.7.2 ................................................. 4

A
ABOUT THIS GUIDE .................................................. iii

B
Building Channels .................................................. 19
Building Controllers ................................................. 24

C
Configuration Studio ................................................. 11
Configuring Assets .................................................. 13
CONFIGURING THE ENTIS SYSTEM .......................... 11
Building Channels .................................................. 19
Building Controllers ................................................. 24
Configuring Assets .................................................. 13
Loading Asset Model on to Servers in the System ........ 16
Starting Configuration studio ................................... 11
Contacts ............................................................. ii
Copyright 2019 Honeywell ........................................ ii
CREATING FLEX OR CLIENT STATIONS ...................... 35

D
Downloading Controllers .......................................... 27
DOWNLOADING SOFTWARE ......................................... 3
Downloading the Equipment Templates ....................... 31

E
ENTIS – Install Shield Wizard ................................... 4
ENTIS as Client ....................................................... 2
EXPORTING CIU 888 DATABASE ................................. 29
Downloading the Equipment Templates ....................... 31

H
HARDWARE REQUIREMENTS ..................................... 2
ENTIS as Client ....................................................... 2

I
INSTALLATION OF ENTIS ........................................... 4
.NET framework 4.7.2 framework .................................. 4
Installing ENTIS as Client or User Interface ............... 9
Installing ENTIS as Server ........................................ 4
Prerequisites .......................................................... 4
Verifying successful installation ................................ 10
Installing ENTIS as Client or User Interface ............... 9
Installing ENTIS as Server ........................................ 4
INSTALLING THE ENTIS LICENSE ............................ 38
Uninstall ENTIS program .......................................... 39

L
Legal aspects .......................................................... iii
Loading Asset Model on to Servers in the System .......... 16

P
Prerequisites .......................................................... 4

Q
Quick Builder - Channel ........................................... 19
Quick Builder - Controller .......................................... 24
Quick Builder - Equipment ........................................... 31
Quick Builder - Station .............................................. 35

R
References ............................................................. iv, 13

S
Safety and prevention of damage ................................ iii
SETUP LOGGING SETTINGS ........................................... 37
SOFTWARE REQUIREMENTS ....................................... 3
DOWNLOADING SOFTWARE ......................................... 3
Starting Configuration studio ................................... 11
Support ................................................................. iii

U
Uninstall ENTIS program ......................................... 39

V
Verifying successful installation ................................. 10
For service-related questions, contact:

**Technical Assistance Centre**  
Phone: +31152701246  
E-mail: HFS-TAC-SUPPORT@honeywell.com

**Copyright © 2019 - Honeywell**  
All rights reserved. No part of this manual may be reproduced in any form, by print, photoprint, microfilm or any other means without the written permission from Honeywell.

**For more information**  
To learn more about ENTIS, visit [www.honeywellprocess.com](http://www.honeywellprocess.com)  
Or contact your Honeywell Account Manager

**Americas**  
Honeywell Enraf Americas, Inc.  
1250 West Sam Houston Pkwy S.  
Houston, TX 77042  
USA  
Phone: +1 (480) 293-2042  
Email: enraf-us@honeywell.com

**Europe, Middle East and Africa**  
Honeywell Enraf  
Delftechpark 39  
2628 XJ Delft  
The Netherlands  
Phone: +31 (0)15 2701 100  
Email: enraf-nl@honeywell.com

**Asia Pacific**  
Honeywell Pte Ltd.  
17 Changi Business Park Central 1  
Singapore 486073  
Phone: +65 6355 2828  
Email: enraf-sg@honeywell.com